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Streamlining your workflow with Flare 7
Eddie VanArsdall explains how the latest version of MadCap 
Flare supports the complete information development cycle.

Since its introduction in early 2006, MadCap 
Flare™ has maintained a steady course of 
evolution. Flare users have helped  foster this 
evolution through proactive feedback.

MadCap obviously listens. Each new version of 
Flare has shown that the organisation understands 
its users, and Flare 7 is no exception. Packed with 
impressive new features and enhancements, 
Flare 7 provides full support for information 
development teams and their workflows.

Setting up your infrastructure
A typical information development project 
requires setting up an infrastructure for 
organising, managing and sharing project files. 
Flare 7 provides three new features that support 
resource sharing and team collaboration.

External Resources pane
While Flare 7 continues to support one-way 
linking to source files, the new External 
Resources pane dramatically extends file 
linking capability. You can connect to local 
and network folders outside of your project 
and create mappings to files in those folders. 
As long as you maintain the connections, you 
can then access the files and folders from any 
project.

You can also establish bi-directional 
synchronization between a file in your project 
and an external file. This is useful if you are the 
‘keeper’ of a specific master file and need to 
ensure that everyone has the latest version.

The External Resources pane also launches 
a Synchronize Files window, where you can 
synchronise, import and export files. You can 
also manage file mappings (Figure 1).

SharePoint Explorer pane
If your team uses Microsoft SharePoint for 
file management and source control, you can 
integrate Flare 7 into your SharePoint workflow. 
The new SharePoint Explorer enables you to 
connect to a SharePoint server and use check-in 
and check-out commands to work on topics. 
As an alternative, you can copy a file to your 
project and use the same bi-directional mappings 
supported by the External Resources pane.

Subversion integration
Apache Subversion (SVN) is a popular, open-
source solution for managing file libraries. 
Flare 7 has native support for Subversion. You 
can bind a new project to Subversion during 
creation, or you can bind an existing project 
using the Project Properties window. No third-
party plug-ins are required.

Developing your content
With your infrastructure in place, you’re ready 
to concentrate on writing. The Flare 7 XHTML 
Editor provides a streamlined authoring 
environment with several useful new features.

Editing toolbar enhancements
The editing toolbar has two new, notable 
additions:

Preview button:��  This button has been 
enhanced to display a drop-down list of all 
output types (called targets) in your project. 
You can easily preview the current topic as 
HTML or PDF without changing the primary 
target.
Insert Snippet and Insert Variable buttons:��  
These two buttons enable you to quickly 
insert snippets and variables (reusable text 
blocks and text strings). This facilitates 
faster editing than using the equivalent menu 
commands.

Auto Suggestion
Flare 7 replaces the former IntelliSense feature 
with an optional but much smarter feature 
called Auto Suggestion. This new feature 
analyses what you type and offers suggestions 
for completion. Those suggestions come from 
system variables such as Long Date, as well 
as from your custom variables and snippets. 
Suggestions appear in a pop-up window, and Figure 1. Synchronize Files window
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you can use the keyboard to select and accept 
an entry.

 Auto Suggestion gives you more control over 
automating text entry than its predecessor. You 
can add a custom Auto Suggestion file to your 
project and use the file to build a preferred list 
of frequently used words and phrases. This 
‘trains’ Auto Suggestion to recognise text that 
you frequently type.

Structure Bars with modified design
The Structure Bars in the Flare editor provide a 
visual representation of the XHTML structure used 
in a topic. In previous versions of Flare, the bars 
represented text and table formatting separately.

In Flare 7, the separate Structure Bars for 
tables are no longer present. Table structure has 
been integrated into the main Structure Bars. 
In addition, the bars provide a more granular 
view of the table markup. You can drill down to 
the cell level and see the interior tags (such as 
lists) that are applied to cell content. This useful 
enhancement gives the editor a much cleaner, 
less cluttered appearance (Figure 2).

New paste options
Pasting text into Flare from another source has 
sometimes been unpredictable. Flare 7 replaces 
the rather intimidating Paste Text window with 
a new, powerful Paste icon.

Flare’s Paste icon resembles that of Microsoft 
Word, but the pop-up menu in the Flare version 

gives you more options: paragraph, paragraph 
block, inline text, table, or list. I find the inline 
text option especially useful for integrating 
pasted text into the destination text without 
having to clean up formatting.

When you paste tables or table text, the Paste 
icon’s dynamic pop-up menu shows commands 
for table formatting. The menu changes 

Figure 2. Flare editor with structure bars on the left
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according to whether you are converting a 
table to text, cutting columns, cutting rows, or 
merging tables. This article further discusses 
Flare 7 table enhancements in a later section.

Equation Editor
Flare 7 supports the Mathematical Markup 
Language, or MathML. Along with this capability, 
MadCap has added a new Equation Editor to 
enable writers to build equations and insert 
them into topics.

The Insert > Equation menu command 
launches the new editor (Figure 3), which offers 
templates for various types of equations. You 
can view equations in either of two views: 
Design or Source. The latter view shows the 
MathML markup.

When building output, Flare converts 
equations into images. XHTML output renders 
them as raster images, and PDF output renders 
them as vector images. For optimal accessibility, 
the Equation Editor provides options for adding 
a screen tip and alternate text (alt text) attribute 
to the equation properties.

Enhanced support for table insertion and editing
Options for inserting and editing tables are 
significantly enhanced in Flare 7:

Insert Table button:��  This new button appears 
on Flare’s Text Formatting toolbar. Similar to 
the equivalent button used in Microsoft Word, 
clicking the button displays a drop-down grid 
on which you can drag down and to the right to 
select the desired number of rows and columns.
Convert table to text:��  As an example, if you 
select a nine-cell table and select the Convert to 
Text command, Flare creates nine paragraphs. 
The dynamic Paste icon remains available, 

enabling you to try other paste options.
Convert text to table:��  You can accomplish 
this task by simply selecting the text, then 
using Flare’s Table menu command (Table > 
Insert > Table) to set up the table structure.
Sort rows:��  You can sort table rows in 
ascending or descending order.
Merge tables:��  If you have two differently 
styled tables separated by an empty 
paragraph, you can determine which style 
takes precedence when you delete the 
paragraph and merge the tables.
Reset Local Cell Formatting:��  Unlike previous 
versions of Flare, this command affects only 
selected cells, rather than the entire table.

Enhanced support for table styles
The Flare 7 Table Style Editor looks similar 
to the previous editor, but it includes many 
improvements. It also gives you much more 
control over table properties and style usage. 
Using the new editor, you can:

Specify that certain properties such as padding ��
be different in specific areas of a table
Exert more control over row and column patterns, ��
including their names and their behaviour
Create a custom pattern type for rows or ��
columns and use it to override other patterns 
in specific instances of styled tables
Use a new Medium drop-down list inside ��
the editor to specify different settings for 
different style sheet media (online and print) 
in one place
Use a new �� Apply Style command to apply a 
table style to selected  files, folders, or to all 
topics in a project. This is a significant and 
welcome improvement.

Quick Response (QR) codes
Flare 7 enables you to insert Quick Response 
(QR) codes into topics. A QR code is a type of 
barcode designed to be read by devices such 
as smartphones. QR codes can encode text, a 
URL, an e-mail address, a contact card (vCard), 
or SMS message text. To read a QR code, your 
phone must have a special reader application. 
Several readers are available at no cost.

In describing one use case for QR codes, 
MadCap suggests that you could provide a code 
for employees who are doing field work and 
need access to your online help. If you design 
for this use case, I recommend that you use 
Flare’s Mobile skin (introduced in Flare 6) to 
design your help for viewing on a mobile device.

Support for new vector image formats
Flare 7 supports three new vector image formats:

Scalable Vector Graphics (SVG), an XML-based ��
format
PostScript (PS)��
Encapsulated PostScript (EPS).��

These file types primarily serve to provide 
better image clarity in printed output. If the 

Figure 3. Flare 7 Equation Editor
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images are used in WebHelp output, Flare 
converts them to .png files.

Conducting editorial reviews
Because Flare is a topic-based writing tool, you 
can send individual topics for review at any point 
in the information development cycle. I find that 
clients often prefer this approach, as they don’t 
like to be overwhelmed by reviewing a large help 
system or PDF guide all in one go, especially if 
they are seeing the content for the first time. When 
your completed work is ready for production, 
clients can then view topics that they have already 
read in the context of the full product.

Previous versions of Flare supported author 
annotations, topic reviews, and contributions 
by outside authors. Flare 7 extends all of these 
capabilities with enhanced review features. 
Some features are designed to work with 
MadCap’s new Contributor product, which 
consolidates the former X‑Edit product family. 
This review discusses only the features that are 
native to Flare 7.

The menu bar now includes a Review menu. 
This menu and the equivalent Review toolbar 
now include a Track Changes feature. You can 
set options for Track Changes using the Review 
Options tab, accessible from the Review menu. 
For example, you can specify your user name 
and initials. You can also specify how changes 
appear in your files.

The Track Changes feature follows industry-
standard conventions. You can show or hide 
changes, navigate through changes, and accept 
or reject them.

Annotations (author comments), which 
previously appeared in a separate pane, now 
appear in the XHTML Editor (Figure 4).

Building, analysing, and refining 
As you develop content, you typically build 
output in designated formats such as WebHelp 
and PDF. As you build output, the Flare 
compiler displays messages to notify you of any 
issues that you need to address. One of those 
issues is accessibility compliance.

Accessibility features and enhancements
While Flare has always included features to support 
web accessibility requirements and standards, 
Flare 7 takes accessibility to a new level.

All Flare targets (output configuration files) 
for WebHelp and PDF now include a Warnings 
tab for accessibility checking (Figure 5). If 
you turn on the warnings, the Flare compiler 
will check for accessibility problems during a 
project build.

The compiler identifies and reports the 
following types of problems:

Images, equations, and QR codes that are ��
missing an alt text attribute
Tables that have no caption or summary��
Tables without a header row��

Form elements with missing labels��
Frame elements without a title or name.��

You can click the compiler’s Save Log button to 
save a date-stamped log to the Reports folder 
in your Flare project. With the log file open, 
you can double-click on any row to open the 
corresponding file that produced the message.

Missing alt text attributes are a common 
accessibility issue. Unless you have added alt 
text to an imported image before inserting the 
image into multiple topics, some instances 
of the image may not include the attribute. 
Fortunately, the Edit Picture window in Flare 7 
includes a time-saving check box labelled ‘Apply 
the alternate text and screen tip to all image 
references’. After adding the attributes for one 
instance of the image, you can check this box to 
update all of the remaining instances.

During PDF compilation, Flare automates the 
following conversions for accessibility:

Figure 4. Tracked changes and annotations

Figure 5. WebHelp Warnings tab
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Converts each alt text attribute to its PDF ��
equivalent so that a screen reader can 
properly describe each image.
Converts XML �� lang attributes to their PDF 
equivalent for the entire PDF file and for any 
languages that may be applied to specific 
XHTML elements.
Converts table structures to their PDF ��
equivalent so that screen readers can properly 
read them.

The PDF target includes a PDF Options tab, with 
some options that duplicate certain settings 
found in Adobe Distiller and Acrobat (such 
as Image Compression and Initial View). You 
will also find a Generate tagged PDF setting, 
which enables you to generate the PDF build 
with structured tagging. The tagging is similar 
to the structure of the source XHTML files in 
your project. Although PDF tagging increases 
the file size, it is required for making a PDF file 
accessible to screen readers. If you have ever 
post-processed a PDF file to add tagging, you will 
appreciate the automation that Flare now offers.

New Reports
To further analyse your project output, you 
can add a new report file, select what you want 
to include in the report, and then generate the 
report. Flare 7 adds a number of useful report 
options for analysis.

One of the available report categories is Context-
sensitive help (CSH). Let’s say that you have 
generated a report to analyse your CSH setup. 
The report lists several topics under the category 
‘Topics Not Linked By Map ID’. You can quickly 
map those topics using Flare’s Alias Editor.

Redesigned Alias Editor
New help authors often find setting up context-
sensitive help a bit daunting. The interplay 
between alias (.ali) files and header (.h) files can 
be confusing.

The redesigned, elegant Alias Editor in Flare 7 
simplifies the process of mapping topics to 
identifiers and building a header file. The editor 
has a clean layout, with a Content tree structure 
on the left, and an Identifiers table on the right 
(Figure 6). The first column in the table marks 
unassigned identifiers with an orange icon. 
Assigned identifiers have a green icon.

The Alias Editor enables you to add identifiers 
to single files, selected multiple files, or the 
entire project. You can associate a header file 
with the alias file and generate its contents.

Assigning topics to identifiers is easy:
1.	 Select an unassigned identifier in the 

Identifiers table.
2.	 Right-click a file in the folder tree on the left.
3.	 Select Assign topic to selected identifier. 

The Identifier table adds the file name and 
the path.

As you assign identifiers and set up your context-
sensitive help, Flare builds a header file that you 
can give to your software development team.

Summary
MadCap Flare has always provided a 
comprehensive feature set for single-sourcing 
and content management. Flare 7 extends these 
capabilities to cover the entire spectrum of 
information development. Download a trial of 
Flare 7 at www.madcapsoftware.com/
downloads   C

Figure 6. Flare 7 Alias Editor
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